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Orange: เครื่องมือสำำหรับกำรโปรแกรมแบบวิชวล
สำำหรับกำรเรียนรู้เครื่องจักรและกำรวิเครำะห์ข้อมูล

คู่มือกำรเรียนรู้ Orange สำำหรับกำรทำำวิจัย

โอฬำริก สุรินต๊ะ
สำขำวิชำเทคโนโลยีสำรสนเทศ

คณะวิทยำกำรสำรสนเทศ มหำวิทยำลัยมหำสำรคำม
มหำสำรคำม ประเทศไทย



คำำนำำ

ด้วยควำมก้ำวหน้ำทำงเทคโนโลยีสำรสนเทศ จึงทำำให้มีข้อมูลเผยแพร่ผ่ำนทำงอินเทอร์เน็ต
อย่ำงรวดเร็ว เช่น ข้อมูลที่โพสต์ในเฟซบุ๊ค ทวิสเตอร์ หรือตำมเว็บไซต์พันทิป ไม่ว่ำจะเป็นข้อมูลที่เป็น
ข้อควำมหรือรูปภำพ ทำำให้ผู้คนบำงกลุ่มต้องกำรที่จะเข้ำถึงข้อมูลเหล่ำน้ัน เพ่ือที่จะนำำมำวิเครำะห์ และ
ใช้ข้อมูลเหล่ำนั้นให้เกิดประโยชน์ เช่น นำำมำช่วยในกำรวำงแผนกำรตลำด และกำรเจำะกลุ่มเป้ำ
หมำย จึงทำำให้เกิดศำสตร์ใหม่ขึ้นมำเพ่ือช่วยในกำรเรียนรู้ และบริหำรจัดกำรข้อมูล เรียกว่ำ วิทยำกำร
ข้อมูล (Data Science) ซึ่งในอดีตเรำจะรู้จักกับคำำว่ำ "เหมืองข้อมูล (Data Mining)" และ "กำรเรียนรู้
เครื ่องจักร (Machine Learning)" โดยทั้งสองแขนงมุ่งเน้นที่อัลกอริทึมที่จะนำำมำใช้เพ่ือกำรเรียนรู้
และกำรพยำกรณ์ข้อมูล แต่อยู่บนพ้ืนฐำนของกำรคำำนวณด้วยวิธีเดียวกัน หำกพูดถึงวิทยำกำรข้อมูล
เปรียบได้กับกำรนำำข้อมูลที่มีอยู่มำผ่ำนกระบวนกำรวิเครำะห์ทำงธุรกิจ เพ่ือให้ธุรกิจเกิดควำมได้เปรียบ
ในกำรแข่งขัน 

ปัจจุบันมีเครื่องมือมำกมำยที่สำมำรถนำำมำใช้ในกำรวิเครำะห์ข้อมูล โดยโปรแกรม Orange มี
ลักษณะกำรทำำงำนแบบ Visualization ทำำให้ผู้ใช้งำนสำมำรถเรียกใช้งำนได้อย่ำงสะดวกและรวดเร็ว
โดยไม่จำำเป็นต้องเขียนโค้ด อีกทั้งยังเป็นโปรแกรมที่สำมำรถดำวน์โหลดและใช้งำนได้ฟรี ผู้เขียนจึงมี
วัตถุประสงค์เพื่อเขียนหนังสือคู่มือกำรใช้โปรแกรม Orange เพ่ือให้ผู้อ่ำนสำมำรถที่จะอ่ำนและปฏิบัติ
ตำมขั้นตอนได้อย่ำงถูกต้อง 

โอฬำริก สุรินต๊ะ
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กำรติดตั้ง (Installation)

• สำมำรถดำวน์โหลด Orange ได้จำกเว็บไซต์ https://orange.biolab.si

• คลิกที่เมนู Download หรือที่ปุ่ม Download Orange

• สำมำรถเลือกดำวน์โหลดโปรแกรมได้ทั้งหมด 3 OS ประกอบด้วย Windows, macOS และ 
Linux / Source

• เมื่อเลือก OS เสร็จเรียบร้อย จำกน้ันให้เลือกที่ Download Orange <version>
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• จำกน้ันไฟล์โปรแกรมที่ดำวน์โหลดจะถูกเก็บไว้ที่โฟลเดอร์ Downloads 
• ตัวอย่ำงได้ดำวน์โหลดไฟล์ของ macOS โดยไฟล์ชื่อ Orange3-3.140.dmg โดยที่ 3.14.0 คือ 

version ของโปรแกรม orange ที่ได้ดำวน์โหลด

• จำกน้ันให้ดับเบิ้ลคลิกที่ไฟล์ Orange3-3.14.0.dmg เพ่ือติดตั้งโปรแกรม
• เมื่อติดตั้งเสร็จเรียบร้อยสำมำรถเปิดโปรแกรมขึ้นมำใช้งำน โดยโปรแกรมที่ติดตั้งเรียกว่ำ 

Orange3
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• เมื่อคลิกเปิดโปรแกรมจะแสดงโลโก้ของโปรแกรม 

• เมื่อแสดงโลโก้ของโปรแกรมเสร็จเรียบร้อยจะเปิดโปรแกรม Orange เพ่ือให้ใช้งำน
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เริ่มต้นใช้งำน Orange (Getting Started with Orange)

• เมื่อเรียกโปรแกรม Orange จะแสดงหน้ำต่ำง Welcome to Orange Data Mining

• จำกหน้ำต่ำง Welcome to Orange Data Mining สำมำรถเลือกเมนูต่ำง ๆ เช่น
◦ สร้ำงไฟล์ใหม่ (New)
◦ เปิดไฟล์เก่ำ (Open)
◦ เปิดไฟล์ล่ำสุด (Recent)
◦ เปิดดูตัวอย่ำง (Examples)

เปิดดูตัวอย่ำง (Examples)

• ในกรณีที่คลิกที่ Examples จะปรำกฎตัวอย่ำงในกำรทำำงำนของโปรแกรม Orange ดังตัวอย่ำง
ต่อไปน้ี
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• เมื่อเลือกตัวอย่ำงที่ต้องกำร ให้คลิกที่ปุ่ม Open เพือเปิดดูตัวอย่ำงน้ัน

เปิดไฟล์เก่ำ (Open)

• หำกต้องกำรเปิดไฟล์เดิมที่มีอยู่แล้วสำมำรถคลิกที่ Open
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• เมื่อคลิกที่ปุ่ม Open โปรแกรมจะให้เลือกไฟล์ของโปรแกรม Orange ซึ่งไฟล์จะมีนำมสกุล .ows
• จำกน้ันคลิกที่ปุ่ม Open เพ่ือเปิดไฟล์ที่ต้องกำรจะทำำงำน

สร้ำงไฟล์ใหม่ (New)

• หำกต้องกำรสร้ำงไฟล์ใหม่สำมำรถคลิกที่ New 
• เมื่อคลิกที่ New จำกน้ันจะปรำกฎหน้ำต่ำง Workflow Info ให้พิมพ์รำยละเอียดของโปรเจคที่

ต้องกำรจะทำำงำน ประกอบด้วย Title และ Description
◦ Title - ชื่อของโปรเจค
◦ Description – รำยละเอียดของโปรเจค

• เมื่อพิมพ์รำยละเอียดที่ต้องกำรให้คลิกที่ปุ่ม OK เพ่ือเริ่มต้นกำรทำำงำน
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• เมื่อคลิกที่ OK จะปรำกฎโปรแกรม Orange ที่พร้อมทำำงำน
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กล่องเครื่องมือ (Toolbox)

Data Visualize

Model
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Evaluate Unsupervised
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ไฟล์และตำรำงข้อมูล (File and Data Table)

ตัวอย่ำงไฟล์และตำรำงข้อมูล (Example of File and Data Table)

• คลิกที่เมนู Help > Examples โปรแกรม Orange จะเปิดตัวอย่ำงของกำรใช้โปรแกรม 

• จำกน้ันให้เลือกที่ File and Data Table และกดที่ปุ่ม Open
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• เมื่อคลิกที่ Open จะปรำกฎตัวอย่ำงกำรใช้งำนไอคอน (Icon) หรือวิดเจท (Widget) File และ 
Data Table

จำกตัวอย่ำงเริ่มต้นโดย 
• ดับเบิ้ลคลิกที่ไอคอน File จำกน้ันจะปรำกฎหน้ำต่ำงที่แสดงชุดข้อมูล (Dataset) 

◦ ในตัวอย่ำงน้ีจะเป็นชุดข้อมูลที่ชื่อ iris ซึ่งเป็นชุดข้อมูลดอกไม้ที่ประกอบไปด้วย 4 attribute 
และ 3 class
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• หำกต้องกำรเลือกข้อมูลชุดอื่นสำมำรถทำำได้โดยคลิกที่รูปโฟลเดอร์ 
• จำกน้ันจะปรำกฎหน้ำต่ำงให้เลือกข้อมูลชุดอื่น

• เมื่อเลือกชุดข้อมูลเสร็จเรียบร้อยให้คลิกที่ปุ่ม Open
• ในกรณีน้ี เลือกใช้ข้อมูลชุด iris
• จำกน้ันให้ดับเบิ้ลคลิกที่ไอคอน Data Table จะปรำกฎหน้ำต่ำงดังต่อไปน้ี
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• โดยหน้ำต่ำงจะแสดงข้อมูลทั้งหมดของชุดข้อมูล iris ซึ่งประกอบด้วยข้อมูลทั้งสิ้น 150 ชุด 
◦ ข้อมูลแต่ละแถว (Instance) จะประกอบไปด้วย 4 attribute / feature คือ

▪ Sepal length
▪ Sepal width
▪ Petal length
▪ Petal width

◦ ข้อมูลมีทั้งหมด 3 กลุ่ม (Class / Label) ประกอบด้วย
▪ iris-setosa
▪ iris-versicolor
▪ iris-virginica

[ที่มำ: https://rpubs.com/wjholst/322258]
◦

เพิ่มไอคอน Visualize (Add Visualize Icon)

• จำกน้ันทำำกำรเพ่ิมไอคอน Visualize เพ่ือที่จะดูลักษณะของข้อมูลของ iris dataset
• ทำำได้โดยเลือกที่แทป (Tab) Visualize และคลิกที่ไอคอน Scatter Plot จำกน้ัน Scatter Plot จะ

ไปปรำกฎใน Workflow ของโปรแกรม
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• ดับเบิ้ลคลิกที่ไอคอน Scatter Plot เพ่ือดูกรำฟ 
◦ โดยกรำฟแสดงให้เห็นถึงกำรกระจำยของข้อมูล
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กำรแสดงข้อมูลเชิงโต้ตอบ (Interactive Visualizations)

• ในส่วนน้ีเป็นกำรแสดงให้เห็นถึงวิธีกำรแสดงข้อมูลแบบ Visualization 
• คลิกที่เมนู Help > Examples โปรแกรม Orange จะเปิดตัวอย่ำงของกำรใช้โปรแกรม 
• ให้คลิกเลือก Interactive Visualizations และคลิกที่ปุ่ม Open

• เมื่อคลิกที่ Open จะปรำกฎตัวอย่ำงกำรใช้งำน Interactive Visualizations ดังตัวอย่ำงต่อไปน้ี
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ขั้นตอนในกำรทำำ Interactive Visualizations ทำำได้ดังต่อไปน้ี
• ดับเบิ้ลคลิกที่ไอคอน File เพ่ือเลือกชุดข้อมูลที่ต้องกำรใช้งำน 

◦ ตัวอย่ำงกำำหนดให้ใช้ชุดข้อมูล iris

• ขั้นตอนต่อไปดับเบิ้ลคลิกที่ไอคอน Scatter Plot โปรแกรมจะแสดงหน้ำต่ำงเพ่ือแสดงข้อมูล
แบบ Visualization 
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• จำกหน้ำต่ำงข้ำงต้นสำมำรถ คลิกข้อมูลแต่ละจุด หรือ ใช้เมำส์คลิกเพ่ือเลือกข้อมูลแบบกลุ่ม 
◦ ตัวอย่ำงแสดงให้เห็นถึงกำรเลือกข้อมูลบำงส่วน จำกน้ันให้คลิกเพ่ือปิดหน้ำต่ำง
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• จำกน้ันดับเบิ้ลคลิกที่ไอคอน Data Table
◦ โปรแกรมจะเปิดหน้ำต่ำงเพ่ือแสดงข้อมูลที่ได้เลือกไว้ในขั้นตอน Scatter Plot



กำรแสดงข้อมูลย่อย (Visualizations of Data Subsets)

• ในส่วนน้ีแสดงให้เห็นถึงกำร Visualization ของชุดข้อมูลย่อย
• คลิกที่เมนู Help > Examples โปรแกรม Orange จะเปิดตัวอย่ำงของกำรใช้โปรแกรม 
• ให้คลิกเลือก Visualization of Data Subsets และคลิกที่ปุ่ม Open

• เมื่อคลิกที่ Open จะปรำกฎตัวอย่ำงกำรใช้งำน Visualization of Data Subsets ดังตัวอย่ำงต่อไป
น้ี
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ขั้นตอนในกำรทำำ Visualization of Data Subsets ทำำได้ดังต่อไปน้ี
• ดับเบิ้ลคลิกที่ไอคอน File เพ่ือเลือกชุดข้อมูลที่ต้องกำรใช้งำน ในตัวอย่ำงใช้ข้อมูล iris
• ดับเบิ้ลคลิกที่ไอคอน Data Table และเลือกข้อมูลที่ต้องกำรนำำไป Visualization
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• ดับเบิ้ลคลิกที่ เส้นเชื่อมต่อระหว่ำง Data Table และ Scatter Plot
◦ ให้สังเกตกำรเชื่อม (Link) ข้อมูลระหว่ำง Data Table และ Scatter Plot

• สุดท้ำย ดับเบิ้ลคลิกที่ Scatter Plot เพ่ือดูข้อมูลชุดย่อยที่ได้เลือกไว้
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กำรแสดงรำยละเอียดข้อมูล (Data Information)

• หำกต้องกำรทรำบรำยละเอียด (Information) ของข้อมูลที่นำำมำใช้งำน สำมำรถทำำได้โดยเลือก
ที่ไอคอน Data Info โดยทำำตำม workflow ดังต่อไปน้ี
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กำรแสดงกำรกระจำยข้อมูล (Data Distributions)

• โปรแกรม Orange มีเครื่องมือ (Tool) ที่ช่วยให้ผู้ใช้งำนสำมำรถดูกำรกระจำยของข้อมูล เช่น 
จำำนวนของข้อมูลในแต่ละ Class จำำนวนของข้อมูลในแต่ละ Attribute เป็นต้น 

• ผู้ใช้งำนสำมำรถเห็นข้อมูลในลักษณะ Visualize ทำำให้เข้ำใจลักษณะของข้อมูลมำกขึ้น

• กำรกระจำยข้อมูล สำมำรถทำำได้ดัง workflow ต่อไปน้ี

• ในกรณีน้ี ข้อมูลที่นำำมำใช้เพ่ือแสดงกำรกระจำยคือชุดข้อมูล iris 
• ผู้ใช้งำนสำมำรถดับเบิ้ลคลิกที่ไอคอน File และเลือกชุดข้อมูลที่ต้องกำรแสดงได้ตำมต้องกำร
• จำกน้ันดับเบิ้ลคลิกที่ไอคอน Distributions จะปรำกฎหน้ำต่ำงดังตัวอย่ำงต่อไปน้ี

• ตัวอย่ำงข้ำงต้น แสดงให้เห็นถึงกำรกระจำยข้อมูลของ Attribute ที่ชื่อ Sepal Length ทำำให้รู้ถึง
ช่วงควำมกว้ำงของ Sepal (Sepal Length) ของดอกไม้ iris ในแต่ละสำยพันธุ์ (Setosa, 
Versicolor และ Virginica) เป็นต้น
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• ตัวอย่ำงต่อไปแสดงให้เห็นถึงจำำนวนของสำยพันธุ์ดอกไม้ iris ในแต่ละ Class โดยในชุดข้อมูล
iris มีจำำนวนดอกไม้ 150 ดอก แบ่งออกเป็น 3 Class และมี Class ละ 50 ดอก
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• ตัวอย่ำงต่อไปน้ี แสดงให้เห็นถึงกำรกระจำยข้อมูลของสัตว์แต่ละประเภท 
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กำรประมวลผลข้อมูลเบื้องต้น (Data Preprocessing)

• กำรประมวลผลข้อมูลเบื้องต้น คือกำรเตรียมข้อมูลให้พร้อมสำำหรับกำรเรียนรู้ เช่น 
◦ บำงครั้งข้อมูลที่จะนำำมำใช้มีข้อมูลบำงส่วนที่สูญหำยไป เรียกว่ำ Missing Value 
◦ ข้อมูลที่จะนำำมำใช้ยังไม่ผ่ำนกำร Normalize ให้อยู่ในช่วงข้อมูลเดียวกัน
◦ ข้อมูลที่นำำมำใช้มีจำำนวน Feature/Attribute เยอะจนเกินไป อำจต้องใช้วิธีกำร เช่น เลือก 

Feature ที่มีควำมสัมพันธ์ (Relevant) หรือใช้วิธี PCA เพ่ือหำ Component ที่เหมำะสมที่สุด 

• ตัวอย่ำงต่อไปน้ี เป็นกำรประมวลผลข้อมูลเบื้องต้น โดยกำร Normalize ข้อมูล Feature สำมำรถ
ทำำได้ดัง workflow ต่อไปน้ี

• ตัวอย่ำงเลือกใช้ข้อมูล iris ในกำรทดสอบ สำมำรถทำำได้โดยดับเบิ้ลคลิกที่ไอคอน File และ
เลือกที่ข้อมูล iris

• ดับเบิ้ลคลิกที่ไอคอน Data Table เพ่ือดูชุดข้อมูล iris ก่อนกำรเปล่ียนแปลง
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• จำกน้ันดับเบิ้ลคลิกที่ไอคอน Preprocess 
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• จำกตัวอย่ำงข้ำงต้น ได้เลือกใช้วิธีกำร Preprocess ด้วยวิธีกำร Normalize ข้อมูล
◦ วิธีกำรเลือกคือใช้เมำส์คลิก วิธีกำรทำงฝั่งซ้ำย และนำำมำวำงหน้ำต่ำงทำงฝั่งขวำมือ

• จำกน้ันดับเบิ้ลคลิกที่ไอคอน Data Table (1) เพ่ือดูกำรเปล่ียนแปลงของข้อมูล
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ต้นไม้จำำแนก (Classification Tree)

• ในส่วนน้ีแสดงให้เห็นถึงวิธีกำรจำำแนก (Classification) ข้อมูลด้วยวิธีต้นไม้ (Tree)
• คลิกที่เมนู Help > Examples โปรแกรม Orange จะเปิดตัวอย่ำงของกำรใช้โปรแกรม 
• ให้คลิกเลือก Classification Tree และคลิกที่ปุ่ม Open

• เมื่อคลิกที่ Open จะปรำกฎตัวอย่ำงกำรใช้งำน Classification Tree ดังตัวอย่ำงต่อไปน้ี
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ขั้นตอนในกำรทำำ Classification Tree ทำำได้ดังต่อไปน้ี
• ดับเบิ้ลคลิกที่ไอคอน File เพ่ือเลือกชุดข้อมูลที่ต้องกำรใช้งำน ในตัวอย่ำงใช้ข้อมูล iris
• ดับเบิ้ลคลิกที่ไอคอน Scatter Plot เพ่ือดูข้อมูลแบบ Visualize
• ดับเบิ้ลคลิกที่ไอคอน Classification Tree จะปรำกฎหน้ำต่ำง Classification Tree เพ่ือกำำหนด

ค่ำ parameter 
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• ดับเบิ้ลคลิกที่ Classification Tree Viewer เพ่ือดู Tree ที่คำำนวณได้จำกข้อมูลชุด iris

• จำกหน้ำต่ำง  Classification Tree Viewer ให้ทดลองเลือกโหนด (Node) จำกตัวอย่ำงเลือก
โหนดแรก
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• จำกน้ันให้ดับเบิ้ลคลิกที่ไอคอน Box Plot จะแสดงหน้ำจอดังต่อไปน้ี

• ทดลองเลือก Node อื่น
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• จำกน้ันเลือก Box Plot อีกครั้ง สังเกตผลลัพธ์ที่ได้จะมีควำมแตกต่ำงกัน
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กำรวิเครำะห์องค์ประกอบหลัก (Principal Component
Analysis: PCA)

• วิธีกำรวิเครำะห์องค์ประกอบหลัก (Principal Component Analysis: PCA) เป็นวิธีในกำร
วิเครำะห์ข้อมูลที่มีหลำยตัวแปร เพ่ือหำควำมสัมพันธ์ของตัวแปรเหล่ำน้ัน วิธี PCA จึงนำำมำเพ่ือ
ใช้ลดขนำดของเมตริกซ์ให้เล็กลง 1

• คลิกที่เมนู Help > Examples โปรแกรม Orange จะเปิดตัวอย่ำงของกำรใช้โปรแกรม 
• ให้คลิกเลือก Principal Component Analysis และคลิกที่ปุ่ม Open

1 PCA: https://www.gotoknow.org/posts/566063
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• เมื่อคลิกที่ Open จะปรำกฎตัวอย่ำงกำรใช้งำน Principal Component Analysis ดังตัวอย่ำงต่อ
ไปน้ี

ขั้นตอนในกำรคำำนวณ PCA ทำำได้ดังต่อไปน้ี
• ดับเบิ้ลคลิกที่ไอคอน File เพ่ือเลือกชุดข้อมูลที่ต้องกำรใช้งำน 

◦ ตัวอย่ำงใช้ข้อมูล molecular biology ที่มีข้อมูลทั้งสิ้น 186 ชุด (Instance) แต่ละชุดมีจำำนวน 
79 Feature / Attribute โดยมีทั้งสิ้น 3 กลุ่ม (Class)

• ดับเบิ้ลคลิกที่ไอคอน PCA เพ่ือแสดงกำรคำำนวณของโปรแกรม



A Guide to Mastering Orange for Research   45

• ดับเบิ้ลคลิกที่ไอคอน Scatter Plot เพ่ือดูค่ำ PCA จำำนวน 2 ตัวแปรที่ดีที่สุด ทั้งน้ีเน่ืองจำกใน 
Scatter Plot น้ันเป็นกำรแสดงข้อมูลแบบสองมิติ (2D)
◦ ในกรณีน้ี ได้เลือกจำำนวนของ Component ที่นำำมำคำำนวณจำำนวน 3 ตัวแปร
◦ โปรแกรมจะแสดง Principle Component (PC) ที่เหมำะสมที่จะนำำมำแสดง จำกตัวอย่ำงคือ 

PC1 และ PC2 
◦ ให้สังเกตที่กรำฟ ข้อมูลทั้ง 3 class จะถูกจำำแนกจำกกันโดยใช้สีในกำรแบ่ง
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แสดง Principal Component ที่ดีที่สุด (Present Best Principal 
Components)

• เรำสำมำรถเลือก Principal Component ที่ดีที่สุด (Best) ที่จะนำำมำแสดงในกรำฟ โดยคลิกที่ปุ่ม 
Find Informative Projections

• เมื่อคลิกที่ Find Informative Projections จะปรำกฎหน้ำต่ำงดังต่อไปน้ี จำกน้ันให้คลิกที่ปุ่ม 
Start โปรแกรมจะคำำนวณและหำ PC จำำนวน 2 ค่ำที่เหมำะสมที่สุด (Best) มำแสดง

• จำกตัวอย่ำงข้ำงต้น โปรแกรมจะคำำนวณและแสดง PC ที่มีควำมเหมำะสมที่สุดจำำนวน 2 ค่ำ 
โดยเรียงตำมลำำดับควำมเหมำะสมจำกมำกไปน้อย ดังน้ัน เรำสำมำรถเลือกค่ำที่เหมำะสมที่สุด
เพ่ือตรวจสอบกำรจำำแนกข้อมูล ดังตัวอย่ำงต่อไปน้ี
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• จำกตัวอย่ำงข้ำงต้นยังแสดงให้เห็นถึงควำมผิดพลำดในกำรจำำแนกข้อมูล เช่น จุดสีแดง 
จำำนวน 2 จุด และจุดสีฟ้ำจำำนวน 1 จุดที่จำำแนกผิด
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กำรเลือกจำำนวน Principal Component ที่ใช้ในกำรคำำนวณ (Selecting
the Number of Principal Components)

• ตัวอย่ำงต่อไปน้ีแสดงให้เห็นถึงกำรนำำ PC จำำนวนทั้งสิ้น 20 Component มำคำำนวณ

• ผลลัพธ์ที่ได้จำกกำรคำำนวณหำค่ำควำมสัมพันธ์ระหว่ำง PC แสดงดังตัวอย่ำงต่อไปน้ี
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กำรเรียกดูค่ำของ Principal Component (Show Value of Principal 
Components)

• ให้เลือกที่ไอคอน Data Table เพ่ือดูค่ำ PC ที่ได้จำกกำรคำำนวณ
◦ ในกรณีที่เลือก PC จำำนวน 20 Component ตำรำงที่แสดงก็จะแสดงข้อมูล PC1 ถึง PC20 
◦ ในกรณีที่เลือก PC จำำนวน 3 Component ตำรำงที่แสดงก็จะแสดงข้อมูล PC1 ถึง PC3

• ข้อมูล PC ทั้งหมดที่เลือกสำมำรถนำำไปใช้ในกำรจำำแนกข้อมูลด้วยวิธีอื่น ๆ เช่น K-Nearest 
Neighbor, Neural Network หรือ Support Vector Machine
 



กำรเรียงตัวแปรตำมลำำดับควำมสำำคัญ (Feature Ranking) 

• ในส่วนน้ีแสดงให้เห็นถึงวิธีกำรคำำนวณเพ่ือหำ Feature หรือ Attribute ที่มีควำมสำำคัญมำกที่สุด
(Rank) โดยคำำนวณจำกควำมสัมพันธ์ (Correlation) ของแต่ละ Feature

• ข้อมูลที่ใช้ในกำรทดสอบชื่อ Brown เป็นชุดข้อมูลยีน (Gene) ที่ประกอบด้วย 186 instance โดย
แต่ละ instance จะมีทั้งสิ้น 79 feature และข้อมูลแบ่งออกเป็น 3 class 

• คลิกที่เมนู Help > Examples โปรแกรม Orange จะเปิดตัวอย่ำงของกำรใช้โปรแกรม 
• ให้คลิกเลือก Feature Ranking และคลิกที่ปุ่ม Open



52   Orange: A Visual Programming Tool for Machine Learning and Data Analytics

• เมื่อคลิกที่ Open จะปรำกฎหน้ำจอดังต่อไปน้ี

ขั้นตอนในกำรคำำนวณ Feature Ranking ทำำได้ดังต่อไปน้ี
• ดับเบิ้ลคลิกที่ไอคอน File เพ่ือเลือกชุดข้อมูลที่ต้องกำรใช้งำน ในกรณีน้ีใช้ข้อมูล Brown 

Selected โดยข้อมูลชุดน้ีจะมีบำงชุดที่ข้อมูลสูญหำย (Missing Value) ไป ดังน้ันจึงต้องคำำนวณ
ข้อมูลใหม่ เพิ่ืิอเติมลงไปในส่วนที่ข้อมูลสูญหำย

กำรเพิ่มไอคอน Data Table (Add Data Table Icon)

• ในกรณีที่ต้องกำรดูว่ำมี instance ไหนบ้ำงที่ข้อมูลสูญหำยไปสำมำรถเพ่ิมไอคอน Data Table 
ลงไปใน workflow 
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• คลิกที่ไอคอน Data Table เพ่ือเปิดดูข้อมูล
◦ จำกตัวอย่ำงข้อมูลที่สูญหำยไปจะแทนที่ด้วยเครื่องหมำยคำำถำม "?”
◦ ในข้อมูลชุดน้ีมีข้อมูลสูญหำยไป 1.5%

• ดับเบิ้ลคลิกที่ไอคอน Impute เพ่ือแทนค่ำข้อมูลที่สูญหำยไป โดย Default Method คือวิธี 
Average/Most frequent และให้คลิกที่ปุ่ม Apply เพ่ืิอคำำนวณและแทนค่ำข้อมูลที่สูญหำย
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• หำกต้องกำรที่จะแสดงข้อมูลให้เพ่ิมไอคอน Data Table ลงไปใน workflow และลำกเส้นเชื่อม
ต่อระหว่ำง Impute และ Data Table (1) 

• ดับเบิ้ลคลิกที่ Data Table (1) ตัวที่เพ่ิมลงไปใหม่ และสังเกตที่ข้อมูล ข้อมูลที่สูญหำยจะถูก
แทนที่ด้วยข้อมูลใหม่
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• จำกน้ันให้ดับเบิ้ลคลิกที่ไอคอน Rank เพ่ือแสดงลำำดับของ Feature ที่มี Score มำกที่สุด โดย
โปรแกรมจะแสดงจำำนวน 2 ลำำดับ

• โดย Feature ที่มี Score มำกที่สุด 2 ลำำดับแรกคือ diau f, spo-early
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• จำกน้ันดับเบิ้ลคลิกที่ไอคอน Scatter Plot เพ่ือดูกำรจำำแนกข้อมูลโดยเป็นกำรนำำ Feature ที่
เลือกไว้ทั้ง 2 ตัว ประกอบด้วย diau f และ spo-early มำแสดงเป็น Visualize
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• หำกต้องกำรนำำ Feature ที่มี Score มำกที่สุดไปใช้งำนต่อในกำรจำำแนกข้อมูลสำมำรถทำำได้
โดยเพ่ิมไอคอม Data Table เข้ำไปใน workflow
◦ ตัวอย่ำงคือกำรเพ่ิม Data Table (2)

กำรสร้ำงกำรเชื่อมต่อเส้นระหว่ำงไอคอน (Create New Link to Icons)

• ขั้นตอนถัดไปคือกำรลำกเส้นเชื่อมต่อระหว่ำง Scatter Plot และ Data Table (2)
◦ เมื่อลำกเส้นเชื่อมกันแล้วจะปรำกฎ เส้นประ แสดงว่ำยังเชื่อมข้อมูลไม่สำำเร็จ 
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◦ ขั้นต่อไป ให้ดับเบิ้ลคลิกที่เส้นประ จะปรำกฎดังหน้ำต่ำงต่อไปน้ี

◦ โดยจะเป็นกำรเชื่อมระหว่ำง Selected Data และ Data ดังน้ัน ให้ลบเส้นน้ีออกและเชื่อม
ใหม่เป็น Data และ Data
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◦ เมื่อเลือกเสร็จแล้วให้กดปุ่ม OK เส้นประจะหำยไปเปล่ียนเป็น เส้นทึบ

• จำกน้ันให้ดับเบิ้ลคลิกที่ไอคอน Data Table (2) เพ่ือเปิดดูข้อมูล
◦ จำกทำำกำำหนดในไอคอน Rank ได้เลือกไว้จำำนวน 2 Feature ดังน้ันในตำรำงที่เปิดมำจึง

ประกอบไปด้วยข้อมูลเฉพำะ 2 Feature เท่ำน้ัน ซึ่งก็คือ diau f และ spo-early 
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กำรแบ่งข้อมูลเพ่ือทดสอบประสิทธิภำพของโมเดล 
(Cross-Validation)

• Cross-Validation คือกำรแบ่งข้อมูลออกเป็น 2 ชุด ประกอบด้วย ชุดเรียนรู้ (Training Set) และ
ชุดทดสอบ (Test Set) เพ่ือนำำข้อมูลชุดเรียนรู้ไปใช้ในกำรสร้ำงโมเดล และใช้ข้อมูลชุดทดสอบ
เพ่ือทดสอบประสิทธิภำพของโมเดลที่ได้สร้ำง 

• กำรทำำ Cross-Validation ข้อมูลจะถูกนำำมำแบ่งเพ่ือทดสอบประสิทธิภำพของโมเดล โดย
กำำหนดให้ทดสอบจำำนวน k-fold เช่น หำกกำำหนดให้ k=3 ก็จะทำำกำรทดสอบจำำนวน 3 ครั้ง 
และในแต่ละครั้งที่ทดสอบข้อมูลก็จะถูกแบ่งออกเป็น 3 ส่วนเท่ำกัน จำกน้ัน 
◦ ข้อมูล K-1 ส่วน (3-1 = 2) จะถูกนำำไปเป็น Training Set เพ่ือสร้ำงโมเดล
◦ ข้อมูล 1 ส่วนจะถูกนำำไปเป็น Test Set เพ่ือทดสอบประสิทธิภำพ

[ที่มำของรูป: wikipedia]

◦ จำกตัวอย่ำง กำำหนด k=4 ดังน้ันจึงต้องทดสอบประสิทธิภำพของโมเดลจำำนวน 4 ครั้ง

ตัวอย่ำงกำรทำำงำนของ Cross-Validation สำมำรถทำำได้โดย
• คลิกที่เมนู Help > Examples โปรแกรม Orange จะเปิดตัวอย่ำงของกำรใช้โปรแกรม 
• ให้คลิกเลือก Cross-Validation และคลิกที่ปุ่ม Open
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• เมื่อคลิกที่ Open โปรแกรมจะเปิด workflow ดังต่อไปน้ี

◦ จำกรูปภำพตัวอย่ำงข้ำงต้น เป็นกำรทดสอบประสิทธิภำพของอัลกอริธึม หรือในโปรแกรม 
Orange จะเรียกว่ำ Learner จำำนวนทั้งสิ้น 3 อัลกอริธีม ประกอบด้วย Logistic Regression, 
Random Forest Classification และ Support Vector Machine (SVM)

◦ ส่วนของ Cross-Validation จะอยู่ในไอคอน Test & Score
◦ ข้อมูลที่ใช้ในกำรทดสอบคือข้อมูลชุด iris

• ดับเบิ้ลคลิกที่ Test & Score จำกน้ันจะปรำกฎหน้ำต่ำง ดังตัวอย่ำงต่อไปน้ี
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◦ ในส่วนของ Sampling สำมำรถกำำหนด parameter ต่ำง ๆ ดังน้ี
▪ Cross validation
▪ Random sampling
▪ Leave one out
▪ Test on train data
▪ Test on test data

◦ ในส่วนของ Evaluation Results ประกอบด้วยผลลัพธ์ทั้งสิ้น 5 วิธี ดังน้ี 
▪ AUC - Area under receiver-operating curve
▪ CA - Classification Accuracy is the proportion of correctly classified examples
▪ F1 – Weighted harmonic mean of precision and recall
▪ Precision – the proportion of true positives among instances classified as positive, 

e.g. the proportion of Iris virginica correctly identified as Iris virginica
▪ Recall – the proportion of true positives among all positive instances in the data, e.g. 

the number of sick among all diagnosed as sick

Cross Validation

กำรแบ่งข้อมูลด้วยวิธี Cross Validation สำมำรถกำำหนด parameter ได้ดังต่อไปน้ี
• Number of folds 

◦ กำำหนดจำำนวนของชุดข้อมูล เช่น หำกกำำหนดให้เป็น 2 fold ดังน้ัน ข้อมูลก็จะถูกแบ่งออก
เป็น 2 ส่วน หำกกำำหนดเป็น 5 fold ข้อมูลก็จะถูกแบ่งเป็น 5 ส่วน และกำรทดสอบก็จะ
ทดสอบจำำนวน 5 รอบ (Iteration)

• Stratified
◦ กำำหนดให้กำรเลือกข้อมูลในแต่ละชุดมีกำรเลือกข้อมูลเท่ำ ๆ กัน เช่น เมื่อข้อมูลที่เลือกมำ

อยู่ใน Class 1 มีจำำนวน 65 instance ดังน้ัน ข้อมูลที่เลือกมำอยู่ใน Class 2 ต้องมีจำำนวน 65 
instance เช่นเดียวกัน
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• จำกตัวอย่ำงข้ำงต้น แสดงผลลัพธ์ของกำรเลือก Cross validation โดยกำำหนดให้มีจำำนวน 3 
และ 5 fold ดังน้ัน ให้สังเกตผลลัพธ์ของวิธี SVM
◦ กำำหนดให้เป็น 3 fold วิธี SVM จะมีควำมถูกต้อง (CA) 0.947
◦ กำำหนดให้เป็น 5 fold วิธี SVM จะมีควำมถูกต้อง (CA) 0.967 ซึ่งเพ่ิมขึ้น

• โดยที่ 0.947 คือ 94.7%
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Random Sampling

• Random Sampling คือกำรสุ่มแบ่ง (Randomly Split) ข้อมูลเป็นสองส่วน (ข้อมูลชุดเรียนรู้ และ
ข้อมูลชุดทดสอบ) เช่น แบ่งออกเป็น 70:30 หรือ 60:40 เป็นต้น โดยกำรทดสอบประสิทธิภำพจะ
ขึ้นอยู่กับจำำนวนที่ต้องกำรทดสอบ (Repeat Train/Test) 

กำรแบ่งข้อมูลด้วยวิธี Random Sampling สำมำรถกำำหนด parameter ได้ดังต่อไปน้ี
• Repeat Train/Test

◦ กำำหนดจำำนวนของกำรทดสอบ เช่น หำกกำำหนดให้มีค่ำเป็น 10 หมำยถึงทำำกำรทดสอบ 10 
รอบ

• Training set size
◦ กำำหนดจำำนวนขนำดของข้อมูลชุดเรียนรู้ เช่น หำกกำำหนดให้มีค่ำเป็น 66% ดังน้ัน หำกมี

ข้อมูลทั้งสิ้น 100 instance ข้อมูลดังกล่ำวจะถูกแบ่งให้เป็น Training set จำำนวน 66 instance
และที่เหลือ 34 instance จะแบ่งเป็น Test set

• Stratified
◦ กำำหนดให้กำรเลือกข้อมูลในแต่ละชุดมีกำรเลือกข้อมูลเท่ำ ๆ กัน เช่น เมื่อข้อมูลที่เลือกมำ

อยู่ใน Class 1 มีจำำนวน 65 instance ดังน้ัน ข้อมูลที่เลือกมำอยู่ใน Class 2 ต้องมีจำำนวน 65 
instance เช่นเดียวกัน

• ตัวอย่ำงต่อไปน้ี กำำหนดให้ Training set size มีขนำด 66% และ 70% ปรำกฎว่ำวิธี SVM 
กำำหนดให้ Training set มีขนำด 66% มีควำมถูกต้อง 0.956 ซึ่งมำกกว่ำกำรแบ่งแบบ 70% ที่มี
ควำมถูกต้อง 0.956
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Leave One Out

• สำำหรับวิธี Leave One Out คือกำรนำำข้อมูลจำำนวน 1 instance แยกออกมำเพ่ือทำำกำร Test และ
ข้อมูลที่เหลือใช้เป็นข้อมูลสำำหรับ Train ดังน้ัน หำกดึงข้อมูลมำทดสอบ n instance ก็จะต้อง
ทดสอบ n ครั้ง (Iteration) ซึ่งวิธีน้ีจะมีควำมแม่นยำำใกล้เคียงกับกำรนำำไปใช้ในชีวิตจริง

• วิธีกำร Leave One Out เป็นวิธีที่มีกำรทำำงำนที่ช้ำ เน่ืองจำกจะต้องทดสอบจำำนวนรอบตำม
จำำนวนของข้อมูล เช่น หำกมีข้อมูล 10,000 instance ก็จะต้องทดสอบ 10,000 iteration น่ัน
หมำยถึงจะต้องสร้ำงโมเดล และทดสอบ 10,000 ครั้ง

[ที่มำ: https://goo.gl/PAQeiJ]

• ผลลัพธ์ที่ได้จำก Leave One Out ด้วยวิธี SVM มีควำมถูกต้อง 0.96 แสดงดังรูปภำพต่อไปน้ี
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Confusion Matrix

• เป็นวิธีที่เปรียบเทียบให้เห็นผลลัพธ์ของกำรพยำกรณ์ (Prediction) และค่ำที่แท้จริง (Actual) 
ของข้อมูล

• จำกรูปข้ำงต้นให้ดับเบิ้ลคลิกที่ไอคอน Confusion Matrix

• ข้อมูลชุด irtis มี class ทั้งสิ้น 3 class ประกอบด้วย setosa, versicolor และ virginica
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• ข้อมูลในแนวแถว (Row) คือ actual class และในแนวคอลัมน์ (Column) คือกำรพยำกรณ์ 
(predicted)

• จำกกำรพยำกรณ์ ปรำกฎว่ำ
◦ แถวแรก Actual class คือ setosa ผลจำกกำรพยำกรณ์ (Predicted) เป็น setosa จำำนวน 50 

แสดงว่ำพยำกรณ์ถูกต้องทั้งหมด
◦ แถวที่สอง Actual class คือ versicolor ผลจำกกำรพยำกรณ์เป็น versicolor จำำนวน 48 และ

พยำกรณ์เป็น verginica จำำนวน 2
◦ แถวที่สำม Actual class คือ verginica ผลจำกกำรพยำกรณ์เป็น verginica จำำนวน 47 และ

พยำกรณ์เป็น versicolor จำำนวน 3



K-Nearest Neighbor (KNN)

[ที่มำ: https://goo.gl/1JR68b]

เริ่มต้นสร้ำงโมเดลของ KNN โดยสร้ำง workflow ใหม่
• ที่เมนูเลือก File > New
• จำกน้ันกำำหนดรำยละเอียดของ workflow (Workflow Info) โดยพิมพ์ข้อมูลลงไปในช่อง Title 

และ Description ของ 
• จำกน้ันเลือกเมนู File > Save เพ่ือบันทึก workflow โดย workflow ที่สร้ำงจะมีนำมสกุล .ows
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• จำกน้ันเลือกไอคอน Datasets จำกแท็ป Data เพ่ือเพ่ิมไอคอน Datasets ลงใน workflow

• ใน workflow ให้ดับเบิ้ลคลิกที่ไอคอน Datasets และเลือก dataset ที่ต้องกำร
◦ ในกรณีให้เลือก Dataset ที่ชื่อ Wine

◦ เมื่อเลือก Dataset ชื่อ Wine จำกน้ันให้คลิกที่ปุ่ม Send Data
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• จำกน้ันเพ่ิมไอคอน Data Table ลงใน workflow

• ที่ไอคอน Datasets ให้คลิกเพ่ือลำกเส้นเชื่อมไปยังไอคอน Data Table

• หำกต้องกำรที่จะดูข้อมูลในชุดข้อมูล Wine ให้ดับเบิ้ลคลิกที่ไอคอน Data Table
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• จำกน้ันที่แท็ป Evaluate ให้เพ่ิมไอคอน Test & Score ลงไปใน workflow 
• ลำกเส้นเชื่อมระหว่ำงไอคอน Datasets และ Test & Score
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• ที่แท็ป Model ให้คลิกเพ่ิมไอคอน KNN ลงไปใน workflow
• ลำกเส้นเชื่อมระหว่ำงไอคอน KNN และ Test & Score

• สำมำรถกำำหนด parameter ให้กับอัลกอริธึม KNN โดยดับเบิ้ลคลิกที่ไอคอน KNN

• Parameter ของ KNN ที่สำมำรถกำำหนดได้ประกอบด้วย
◦ Number of neighbors
◦ Metric
◦ Weight
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• เมื่อกำำหนด parameter ให้กับ KNN เรียบร้อย จำกน้ันให้ดับเบิ้ลคลิกที่ไอคอน Test & Score 
เพ่ือดูผลลัพธ์ที่ได้จำก KNN
◦ โดยสำมำรถกำำหนดกำรทำำ Cross-Validation ได้

• จำกน้ันเลือกที่แท็ป Evaluate และเลือกที่ไอคอน Confusion Matrix เพ่ือเพ่ิมลงไปใน 
workflow

• สำมำรถดับเบิ้ลคลิกที่ไอคอน Confusion Matrix เพ่ือดูคำำตอบที่ได้จำกกำรพยำกรณ์
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กำรพยำกรณ์ด้วยวิธี KNN (KNN Prediction)

• หำกต้องกำรดูผลกำรพยำกรณ์ของข้อมูลในแต่ละ instance สำมำรถทำำได้โดยใช้ไอคอน 
Prediction

• สร้ำง workflow ดังตัวอย่ำงต่อไปน้ี

• ดับเบิ้ลคลิกที่ไอคอน Datasets และเลือกชุดข้อมูล wine
• ดับเบิ้ลคลิกที่ไอคอน Data Sampler และเลือกวิธี Sampling Type ที่ต้องกำร

◦ Fixed proportion of datasets
◦ Fixed sample size
◦ Cross validation
◦ Bootstrap
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• จำกตัวอย่ำงเลือก Fixed proportion of data และกำำหนดขนำด 32% 
◦ หมำยถึงเลือกข้อมูลมำจำำนวน 32% ของข้อมูลทั้งหมด

• ดับเบิ้ลคลิกที่ไอคอน KNN จะปรำกฎหน้ำต่ำงดังต่อไปน้ี และโปรแกรมจะกำำหนดค่ำมำตรฐำน
ของ parameter ดังน้ี
◦ Number of neighbors = 5
◦ Metric = Euclidean
◦ Weight = Uniform
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• ดับเบิ้ลคลิกที่ไอคอน Predictions เพ่ือดูผลลัพธ์จำกกำรพยำกรณ์
• จำกรูปภำพข้ำงต้น แสดงให้เห็นถึงผลลัพธ์ของกำรพยำกรณ์ของแต่ละ instance

- กำรพยำกรณ์แสดงทำง column ทำงฝั่งซ้ำย
- Column ทำงฝั่งขวำ คือ Actual Class

- จำกตัวอย่ำง 0.20 : 0.20 : 0.60 → 3 | Actual = 1
ควำมน่ำจะเป็นที่จะเป็น Class 1 ที่ 0.20
ควำมน่ำจะเป็นที่จะเป็น Class 2 ที่ 0.20
ควำมน่ำจะเป็นที่จะเป็น Class 3 ที่ 0.60
คำำตอบที่ได้จึงเป็น Class 3 ซึ่งเป็นคำำตอบที่ ผิด
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• ดับเบิ้ลคลิกที่ไอคอน Confusion Matrix เพ่ือดูภำพรวมของกำรพยำกรณ์

◦ จำกกำรพยำกรณ์ มีกำรพยำกรณ์ผิดพลำดจำำนวน 15 instance (2+1+7+1+4)

KNN Parameter Tuning (กำรปรับค่ำพำรำมิเตอร์ของ KNN)

• หำกต้องกำรให้ผลกำรกำรพยำกรณ์มีควำมถูกต้องแม่นยำำขึ้นในอัลกอริทึมของ KNN สำมำรถ
ทำำได้โดย ดับเบิ้ลคลิกที่ไอคอน KNN

•
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◦ จำกตัวอย่ำงทดลองปรับค่ำพำรำมิเตอร์ โดยกำำหนดให้ 
▪ Number of neighbors = 3
▪ Metric = Euclidean
▪ Weight = Distance

• ดับเบิ้ลคลิกที่ไอคอน Predictions เพ่ือตรวจสอบผลกำรพยำกรณ์

• ดับเบิ้ลคลิกที่ไอคอน Confusion Matrix เพ่ือดูภำพรวมของกำรพยำกรณ์
◦ จำกตัวอย่ำงแสดงให้เห็นว่ำ กำรพยำกรณ์ไม่มีควำมผิดพลำด
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กำรวิเครำะห์กำรถดถอย (Linear Regression)

• กำรวิเครำะห์กำรถดถอย เป็นกำรศึกษำควำมสัมพันธ์ระหว่ำงตัวแปรตั้งแต่ 2 ตัวแปรขึ้นไป ซึ่ง
ได้แก่ ตัวประมำณกำร (Predictor, X) และตัวตอบสนอง (Response, y) โดยเป็นควำมสัมพันธ์
แบบเชิงเส้น (Linear) 2

[ที่มำ: https://goo.gl/eCvgqv]

• ในโปรแกรม Linear Regression สำมำรถทำำได้ ดังตัวอย่ำงต่อไปน้ี

• ดับเบิ้ลคลิกที่ไอคอน File และเลือกชุดข้อมูล Housing
◦ ข้อมูลชุดน้ีประกอบด้วยข้อมูลจำำนวน 506 instance โดยมีทั้งสิ้น  13 feature ผลลัพธ์เป็น

ข้อมูลประเภทตัวเลข (Numerical Class) เหมำะสำำหรับกำรนำำมำทดสอบ Regression

2 Linear Regression: https://goo.gl/w3pLND
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• จำกน้ันดับเบิ้ลคลิกที่ไอคอน Linear Regression จะปรำกฎหน้ำต่ำงให้กำำหนดค่ำ parameter

• ดับเบิ้ลคลิกที่ไอคอน Data Sampler เพ่ือเลือกขนำดของข้อมูลที่จะทำำกำรทดสอบ
• จำกน้ัน ดับเบิ้ลคลิกที่ไอคอน Test & Score เพ่ือดูผลลัพธ์ที่ได้จำก Linear Regression วิธีที่ใช้

วัดควำมถูกต้องของ Regression ประกอบด้วย Mean Square Error (MSE), Root MSE 
(RMSE), Mean Absolute Error (MAE) และ R2
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• จำกน้ันดับเบิ้ลคลิกที่ไอคอน Predictions เพ่ือดูผลลัพธ์ที่ได้จำกกำรพยำกรณ์ โดยกำร
พยำกรณ์จะไม่ได้พยำกรณ์ออกมำเป็น Class แต่จะพยำกรณ์ออกมำเป็นตัวเลข ดังน้ัน จึง
จำำเป็นต้องใช้ค่ำ Error ในกำรหำควำมถูกต้องของอัลกอริทึม
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K-Means Clustering

• K-Means Clustering เป็นวิธีกำรในกำรแบ่งกลุ่มข้อมูล (Clustering) ซึ่งเป็นกำรเรียนรู้แบบไม่มี
กำรเรียนกำรสอน (Unsupervised Learning) 

• กำรเรียนรู้เริ่มต้นด้วยกำรกำำหนดจำำนวนกลุ่ม และจุดเริ่มต้นของกลุ่ม (Centroid) ให้กับชุด
ข้อมูลโดยกำรสุ่ม

• ข้อมูลแต่ละชุด (Instance) จะถูกนำำไปคำำนวณเพ่ือหำค่ำระยะห่ำง (Distance Function) กับ 
Centroid ทั้งหมด และหำกข้อมูลชุดน้ันมีค่ำใกล้เคียงกับ Centroid ของกลุ่มไหนที่สุด ข้อมูลชุด
น้ันจะถูกกำำหนดให้เป็นสมำชิกของ Centroid กลุ่มน้ัน

• ทำำกำรเรียนรู้ไปเรื่อย ๆ จนกว่ำสมำชิกของแต่ละ Centroid จะไม่มีกำรเปล่ียนแปลง หรือตำม
จำำนวนรอบ (Iteration) ที่ได้กำำหนดไว้

[ที่มำ: https://goo.gl/QEmBVp]
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กำรทำำงำนของ K-Means สำมำรถสร้ำง workflow ตำมตัวอย่ำงดังต่อไปน้ี

• เมื่อสร้ำง workflow ดังตัวอย่ำงข้ำงต้น จำกน้ันดับเบิ้ลคลิกที่ไอคอน File เพ่ือเลือกชุดข้อมูล 
iris

• ดับเบิ้ลคลิกที่ไอคอน Data Sampler เพ่ือกำำหนดขนำดข้อมูลที่ใช้ในกำรเรียนรู้ และทดสอบ
• ดับเบิ้ลคลิกที่ไอคอน K-means เพ่ือกำำหนด parameter ดังต่อไปน้ี

◦ หำกทรำบจำำนวนของกลุ่มที่แน่นอน สำมำรถระบุจำำนวนกลุ่มที่ต้องกำร ให้เลือกที่ Fixed 
ในกรณีน้ีได้เลือกที่ Fixed และกำำหนดให้เป็น 3 กลุ่ม

◦ หำกไม่ทรำบจำำนวนที่แน่นอนของกลุ่ม สำมำรถทำำกำรทดสอบได้ว่ำจำำนวนกลุ่มเท่ำไหร่ที่
เหมำะสม สำมำรถเลือกได้จำก From …. to ….. โดยกำำหนดจำำนวนกลุ่มที่ต้องกำรเช่น 
From 2 to 8

◦ จำำนวนรอบสูงสุดที่ใช้ในกำรเรียนรู้ Maximum iterations กำำหนดไว้ 300 รอบ แต่ทั้งน้ี
หำกข้อมูลไม่มีกำรเปล่ียนแปลงโปรแกรมจะหยุดกำรทำำงำนก่อนครบ 300 รอบ
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• ดับเบิ้ลคลิกที่ไอคอน Scatter Plot เพ่ือดูกำรแบ่งข้อมูลแบบ Visualize
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• ดับเบิ้ลคลิกที่ไอคอน Data Table เพ่ือดูผลลัพธ์ที่ได้จำกกำรพยำกรณ์
◦ ผลลัพธ์จำกกำรพยำกรณ์จะให้คำำตอบเป็น C1, C2 และ C3 แทนคำำตอบ

กำรทำำงำนของ K-Means Clustering สำมำรถสร้ำง workflow ที่แตกต่ำงกันออกไปได้ เช่น

• ในกำรกำำหนดค่ำต่ำง ๆ กำำหนดเหมือนกับตัวอย่ำง K-Means Clustering ก่อนหน้ำน้ี
• จำกน้ันดับเบิ้ลคลิกที่ไอคอน Predictions เพ่ือดูผลลัพธ์ที่ได้จำกกำรพยำกรณ์

◦ ผลลัพธ์จำกกำรพยำกรณ์จะให้คำำตอบเป็น C1, C2 และ C3 แทนคำำตอบ
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Interactive k-Means

• กำรใช้งำน K-Means ในรูปแบบของกำรปฏิสัมพันธ์ (Interactive) จะต้องลงโปรแกรมเสริม 
(Add-ons…)

กำรติดต้ังโปรแกรม Add-on (Installing Add-on Program)

• ให้เลือกที่เมนู Options > Add-ons จำกน้ันจะปรำกฎหน้ำต่ำง ดังต่อไปน้ี

• ให้คลิกเลือก Educational และกดที่ปุ่ม OK เพ่ือทำำกำรติดตั้ง
• เมื่อติดตั้งเสร็จเรียบร้อยให้ปิด และเปิดโปรแกรม Orange เพ่ือทำำให้โปรแกรมสำมำรถใช้ Add-

on ที่ติดตั้งลงไปใหม่ได้
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• หำกติดตั้งเสร็จเรียบร้อยจะมีแท็ปใหม่ปรำกฎ ชื่อว่ำ Educational

กำรทำำ Interactive k-Means สำมำรถทำำได้โดย
• เปิด workflow ขึ้นใหม่และเพ่ิมไอคอนลงไป ดังต่อไปน้ี

◦ Paint Data
◦ Interactive k-Means

กำรสร้ำงข้อมูลด้วยไอคอน Paint Data (Creating Data using Paint 
Data Icon)

• จำกน้ันดับเบิ้ลคลิกที่ Paint Data เพ่ือสร้ำงข้อมูล ดังตัวอย่ำงต่อไปน้ี
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• ขั้นตอนต่อไป ดับเบิ้ลคลิกที่ไอคอน Interactive k-Means โปรแกรมจะแสดงกำรแบ่งกลุ่ม
ข้อมูล ดังตัวอย่ำงต่อไปน้ี

• จำกตัวอย่ำงเรำสำมำรถใช้เมำส์คลิกเลือกจุด Centroid ได้
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• อีกทั้งยังสำมำรถกำำหนดจำำนวนกลุ่มได้

• โปรแกรมจะแสดงกำรแบ่งกลุ่มแบบ Visualize เพ่ือให้สำมำรถเข้ำใจลักษณะของข้อมูลได้ง่ำย
ขึ้น



Support Vector Machine (SVM)

• Support Vector Machine (SVM) เป็นอัลกอริทึมที่ใช้ในกำรจัดหมวดหมู่ข้อมูล (Classification) 
แรกเริ่มอัลกอริทึม SVM ได้พัฒนำเพ่ือกำรจัดหมวดหมู่ข้อมูลที่มีเพียงสองกลุ่มหรือ Binary 
Classification โดยใช้เส้นระนำบ (Hyperplane) เป็นตัวแบ่งข้อมูลสองกลุ่มออกจำกกัน โดย 
Hyperplane น้ันจะเป็นเส้นตรง จึงเรียกว่ำ Linear Kernel แสดงดังภำพต่อไปน้ี

[ที่มำ: https://goo.gl/5XfMnY]

• จำกรูปภำพข้ำงต้น เส้น hyperplane (เส้นทึบสีดำำ) จะใช้เป็นเส้นแบ่งข้อมูล 2 กลุ่มออกจำกกัน 
โดย hyperplane จะมี Margin (เส้นประสีนำ้ำเงิน) ประกบทั้งสองข้ำง หำก Margin ที่ขนำดกว้ำง 
(Maximum Margin) แสดงว่ำข้อมูลที่นำำมำจัดหมวดหมู่มีควำมแตกต่ำงกัน แต่หำก Margin 
แคบแสดงว่ำข้อมูลที่นำำมำจัดหมวดหมู่อำจมีควำมใกล้เคียงกันมำก โดยจุดที่เส้น Margin ลำก
ผ่ำนคือจุด Support Vector

[ที่มำ: https://goo.gl/JK4nKH]
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• จำกรูปภำพข้ำงต้นได้จำำลองเส้น Hyperplane จำำนวนสองเส้นคือ H1 และ H2 โดยทั้ง H1 และ
H2 สำมำรถแบ่งข้อมูลออกเป็น 2 กลุ่มได้อย่ำงถูกต้อง 

• แต่ทั้งน้ีเส้น H1 มี Margin ที่แคบกว่ำเส้น H2 ดังน้ัน หำกมีข้อมูลใหม่ปรำกฎขึ้น ใกล้กับเส้น 
H1 อำจทำำให้กำรจัดหมวดหมู่ผิดพลำดได้ ดังน้ัน เส้น Hyperplane ที่ดีที่สุดคือเส้นที่มี Margin
ที่กว้ำงที่สุด หรือ Maximum Margin

Kernel Function ที่ใช้ใน SVM (SVM Kernel Functions)

• โดยปกติ Kernel Function ที่ใช้ใน SVM คือ Liner Kernel แต่ Linear Kernel น้ีเป็นสมกำรเส้น
ตรงจึงทำำให้อำจเกิดข้อผิดพลำดได้หำกข้อมูลมีควำมซับซ้อน จึงได้มีผู้คิดค้น Kernel Function
เพ่ือทำำให้กำรจัดหมวดหมู่ข้อมูลทำำได้ดีขึ้น 

• Kernel Function ที่ใช้ใน SVM  ประกอบด้วย
◦ Linear Kernel
◦ RBF Kernel
◦ Polynomial Kernel

[ที่มำ: http://mlpy.sourceforge.net/docs/3.4/svm.html]

• รูปภำพข้ำงต้น แสดงให้เห็นถึงกำรปรับค่ำพำรำมิเตอร์ C ใน RBF Kernel 
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[ที่มำ: https://goo.gl/QJSTL9]

• รูปภำพข้ำงต้น แสดงให้เห็นถึงกำรปรับค่ำ gamma เพ่ือให้อัลกอริทึมสำมำรถจัดหมวดหมู่ข้อมูล
ได้ดีขึ้น แต่ทั้งน้ีอำจทำำให้เกิดกำร Overfitting
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กำรทำำงำนของ SVM สำมำรถสร้ำง workflow ตำมตัวอย่ำงดังต่อไปน้ี

• ดับเบิ้ลคลิกที่ไอคอน File เพ่ือเลือกชุดข้อมูล ในกรณีน้ีใช้ชุดข้อมูล iris
• ดับเบิ้ลคลิกที่ไอคอน Data Sampler เพ่ือสุ่มเลือกข้อมูลที่ใช้ในกำรสร้ำงโมเดล และพยำกรณ์
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• ดับเบิ้ลคลิกที่ไอคอน SVM เพ่ือปรับค่ำพำรำมิเตอร์ที่ใช้ในกำรเรียนรู้

• ดับเบิ้ลคลิกที่ไอคอน Predictions เพ่ือดูผลลัพธ์ที่ได้จำกกำรพยำกรณ์ด้วยวิธี SVM
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• ดับเบิ้ลคลิกที่ไอคอน Confusion Matrix เพ่ือดูผลลัพธ์ โดยแสดงผลลัพธ์ตำมกลุ่มข้อมูล
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• ดับเบิ้ลคลิกที่ไอคอน Scatter Plot เพ่ือดูข้อมูลกำรจัดหมวดหมู่ด้วย SVM แบบ Visualize
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Neural Network

[ที่มำ: http://www.mdpi.com/2078-2489/3/4/756]

• Neural Network เป็นวิธีในกำรจัดหมวดหมู่ข้อมูล ที่อยู่ในกลุ่มของ Supervised Learning ซึ่ง
หมำยถึงกำรเรียนรู้จะต้องใช้ Label เพ่ือช่วยในกำรเรียนรู้ โดย Neural Network ที่แสดงดังรูป
ข้ำงต้นเป็น Network แบบ Multi-Layer Perceptron ซึ่งจะต้องประกอบด้วย Input Layer, 
Hidden Layer และ Output Layer

• จำำนวนของโหนดใน Input Layer จะขึ้นอยู่กับจำำนวนของ Attribute หรือ Feature
• จำำนวนของโหนดใน Output Layer ขึ้นอยู่กับจำำนวนของ Class เช่น หำกใช้ชุดข้อมูล iris ซึ่งมี

3 Class ดังน้ัน Output Layer จะมีจำำนวน 3 โหนด
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กำรทำำงำนของ Neural Network สำมำรถสร้ำง workflow ตำมตัวอย่ำงดังต่อไปน้ี

• ดับเบิ้ลคลิกที่ไอคอน File เพ่ือเลือกชุดข้อมูล ในกรณีน้ีใช้ชุดข้อมูล iris
• ดับเบิ้ลคลิกที่ไอคอน Data Sampler เพ่ือสุ่มเลือกข้อมูลที่ใช้ในกำรสร้ำงโมเดล และพยำกรณ์
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• ดับเบิ้ลคลิกที่ไอคอน Neural Network เพ่ือปรับค่ำพำรำมิเตอร์ที่ใช้ในกำรเรียนรู้

• ดับเบิ้ลคลิกที่ไอคอน Predictions เพ่ือดูผลลัพธ์ที่ได้จำกกำรพยำกรณ์ด้วยวิธี Neural Network
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• ดับเบิ้ลคลิกที่ไอคอน Confusion Matrix เพ่ือดูผลลัพธ์ โดยแสดงผลลัพธ์ตำมกลุ่มข้อมูล

• ดับเบิ้ลคลิกที่ไอคอน Scatter Plot เพ่ือดูข้อมูลกำรจัดหมวดหมู่ด้วย Neural Network แบบ 
Visualize
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Deep Neural Network

[ที่มำ: https://goo.gl/CqSmbq]

• ควำมแตกต่ำงระหว่ำง Neural Network หรืออำจจะเรียกว่ำ Simple Neural Network และ Deep
Neural Network ก็คือจำำนวนชั้นของ Layer 

• โดยปกติแล้ว Neural Network แบบ Multi-Layer Perceptron (MLP) จะประกอบด้วย Network 
จำำนวน 3 ชั้นประกอบด้วย
◦ ชั้นนำำเข้ำ (Input Layer)
◦ ชั้นซ่อน (Hidden Layer)
◦ ชั้นแสดงผล (Output Layer)

• แต่ในส่วนของ Deep Neural Network จะทำำกำรเพ่ิมชั้น Hidden Layer ให้เพ่ิมมำกขึ้น ดูจำก
ตัวอย่ำงข้ำงต้น (รูปด้ำนขวำ) มีจำำนวน Hidden Layer ทั้งสิ้น 4 ชั้น ซึ่งจะทำำให้เพ่ิมกำรคำำนวณ
ให้มำกขึ้น ทำำให้สำมำรถเรียนรู้ข้อมูลได้ดีขึ้น
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• กำรกำำหนด Deep Neural Network ในโปรแกรม orange สำมำรถทำำได้โดยดับเบิ้ลคลิกที่
ไอคอน Neural Network จำกน้ันเปล่ียน parameter ในส่วนของ Neurons per hidden layer 
ดังตัวอย่ำงต่อไปน้ี

• จำกตัวอย่ำงข้ำงต้นได้กำำหนดให้ Neurons per hidden layer มีค่ำเป็น 100,50,30,20            
ซึ่งหมำยควำมว่ำ กำำหนดให้มี Hidden Layer จำำนวน 4 ชั้น F ดยแต่ละชั้นประกอบด้วย
◦ Hidden Layer ชั้นที่ 1 มีจำำนวน 100 Neurons
◦ Hidden Layer ชั้นที่ 2 มีจำำนวน 50 Neurons
◦ Hidden Layer ชั้นที่ 3 มีจำำนวน 30 Neurons
◦ Hidden Layer ชั้นที่ 4 มีจำำนวน 20 Neurons



กำรวิเครำะห์รูปภำพ (Image Analytics)

• กำรใช้งำนเครื่องมือของ Image Analytics จะต้องลงโปรแกรมเสริม (Add-ons…)
• ให้เลือกที่เมนู Options > Add-ons จำกน้ันจะปรำกฎหน้ำต่ำง ดังต่อไปน้ี

• จำกน้ันคลิกเลือกที่ Image Analytics และคลิกที่ปุ่ม OK
• เมื่อติดตั้งเสร็จเรียบร้อยให้ ปิดและเปิดโปรแกรม orange อีกครั้ง โปรแกรม Image Analytics ถึง

จะใช้งำนได้
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• เมื่อเปิดโปรแกรม orange โปรแกรมจะมีแท็ปของ Image Analytics เพ่ิมเข้ำมำ ดังตัวอย่ำงต่อไป
น้ี

• ก่อนที่จะใช้งำน Image Analytics จะต้องเตรียมข้อมูลรูปภำพให้พร้อม ในกรณีน้ีได้เตรียม
รูปภำพ โดยมีรูปภำพอยู่ 3 หมวด ประกอบด้วย banana, orange และ pineapple ซึ่งโปรแกรมจะ
ใช้ชื่อของโฟลเดอร์เป็นชื่อของหมวดหมู่
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• จำกน้ันสร้ำง workflow ให้เหมือนดังตัวอย่ำงต่อไปน้ี

• เมื่อสร้ำง workflow เสร็จเรียบร้อยให้ดับเบิ้ลคลิกที่ Import Images และเลือกโฟลเดอร์รูปภำพ
ที่ได้เตรียมไว้

• จำกน้ันให้ดับเบิ้ลคลิกที่เส้นเชื่อม (Link) ระหว่ำง Image Viewer และ Image Embedding
◦ เมื่อปรำกฎหน้ำต่ำงให้เลือกกำรเชื่อมต่อระหว่ำง Data และ Images
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• จำกน้ันดับเบิ้ลคลิกที่ไอคอน Image Viewer เพ่ือเปิดดูรูปภำพที่ใช้ในกำรวิเครำะห์

• ขั้นตอนต่อไปให้ทำำกำรดับเบิ้ลคลิกที่ไอคอน Image Embedding เพ่ือเลือกโมเดลที่จะใช้ใน
กำรวิเครำะห์รูปภำพ 



116   Orange: A Visual Programming Tool for Machine Learning and Data Analytics

Deep Convolutional Neural Network (Deep CNN)

• ในขั้นตอนของ Image Embedding น้ันจะใช้โมเดลของ Deep CNN โดยมีโมเดลให้เลือกดังน้ี
◦ Inception v3
◦ VGG-16
◦ VGG-19

• โมเดลทั้ง 3 น้ันได้มำจำกกำรเรียนรู้จำกข้อมูล ImageNet ซึ่งใช้รูปภำพในกำรเรียนรู้เพ่ือสร้ำง
โมเดลมำกกว่ำล้ำนรูปภำพ

[ที่มำ: http://www.mdpi.com/1099-4300/19/6/242]

Inception v3 

• ในกรณีน้ี เลือกใช้โมเดล Inception v3 สำำหรับกำรวิเครำะห์รูปภำพ 
• ขั้นตอนในกำร Analysis รูปภำพอำจใช้เวลำในกำรประมวลผลนำน
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• หลังจำกประมวลผลเสร็จเรียบร้อย ให้ดับเบิ้ลคลิกที่ไอคอน Image Grid เพ่ือดูกำรจัดกลุ่ม
รูปภำพ

• หำกต้องกำรดูข้อมูลที่ใช้ในกำรประมวลผลสำมำรถดับเบิ้ลคลิกได้ที่ไอคอน Data Table
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VGG-16

• ในกรณีที่ต้องกำรเปล่ียนโมเดลเป็น VGG-16 สำมำรถทำำได้โดยดับเบิ้ลคลิกที่ไอคอน Image 
Embedding และเปล่ียน parameter ของ Embedder เป็น VGG-16 จำกน้ันรอให้โปรแกรม
ประมวลผล 

• เมื่อรอจนประมวลผลเสร็จให้ดับเบิ้ลคลิกที่ไอคอน Image Grid เพ่ือดูผลลัพธ์
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VGG-19

• ในกรณีที่ต้องกำรเปล่ียนโมเดลเป็น VGG-19 สำมำรถทำำได้โดยดับเบิ้ลคลิกที่ไอคอน Image 
Embedding และเปล่ียน parameter ของ Embedder เป็น VGG-19 

• เมื่อโปรแกรมประมวลผลเสร็จเรียบร้อยให้ดับเบิ้ลคลิกที่ไอคอน Image Grid เพ่ือดูผลลัพธ์
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กำรจัดหมวดหมู่รูปภำพใบหน้ำ (Face Image Classification)

• โปรแกรม Orange สำมำรถจัดหมวดหมู่รูปภำพใบหน้ำ โดยโปรแกรมได้เลือกใช้โมเดล 
OpenFace ในกำรจัดหมวดหมู่รูปภำพใบหน้ำ ซึ่งโมเดลน้ีใช้ชุดข้อมูล FaceScrub และ CASIA-
WEBFace ในกำรเรียนรู้เพ่ือสร้ำงโมเดล

• ในกรณีน้ี ได้เลือกทดสอบโมเดลโดยใช้ข้อมูลนักฟุตบอลจำำนวน 3 คน ได้แก่ Messi, Ronaldo 
และ Salah โดยแต่ละคนมีรูปภำพประมำณ 5-6 รูป

• รูปภำพนักฟุตบอลจะถูกจัดเก็บแยกออกเป็นโฟลเดอร์ ดังตัวอย่ำงต่อไปน้ี

• เมื่อเตรียมข้อมูลรูปภำพบุคคลเสร็จเรียบร้อยให้สร้ำง workflow ดังตัวอย่ำงต่อไปน้ี



122   Orange: A Visual Programming Tool for Machine Learning and Data Analytics

• จำกน้ันดับเบิ้ลคลิกที่ไอคอน Import Images และเลือกโฟลเดอร์รูปภำพใบหน้ำที่ต้องกำร

• เมื่อเลือกรูปภำพเสร็จเรียบร้อย จำกน้ันดับเบิ้ลคลิกที่ไอคอน Image Viewer เพ่ือดูรูปภำพที่ใช้
ในกำรจัดหมวดหมู่
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• จำกน้ันดับเบิ้ลคลิกที่ Link ระหว่ำง Image Viewer และ Image Embedding และเปล่ียนกำร
เชื่อมต่อให้เป็น Data และ Images

OpenFace

• สำำหรับกำรจัดหมวดหมู่รูปภำพใบหน้ำจะต้องใช้โมเดล OpenFace 
• ดับเบิ้ลคลิกที่ไอคอน Image Embedding และเปล่ียน Embedder ให้เป็น openface
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• ขั้นตอนสุดท้ำย ให้ดับเบิ้ลคลิกที่ Image grid เพ่ือดูผลลัพธ์ของกำรจัดหมวดหมู่รูปภำพใบหน้ำ
บุคคล

• หำกต้องกำรตรวจสอบควำมถูกต้องของกำรจัดหมวดหมู่รูปภำพใบหน้ำ สำมำรถเพ่ิมไอคอนลง
ไปใน workflow ดังตัวอย่ำงต่อไปน้ี
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• จำกตัวอย่ำงได้เพ่ิมไอคอน Scatter Plot และ Data Table เพ่ือตรวจสอบกำรจัดหมวดหมู่ และดู
ข้อมูลว่ำถูกต้องหรือไม่

• จำกน้ันให้ดับเบิ้ลคลิกที่ไอคอน Scatter Plot เพ่ือดูกำรจัดหมวดหมู่ของรูปภำพ

• หำกต้องกำรตรวจสอบให้แน่ชัดว่ำ จุดวงกลมสีฟ้ำ คือรูปภำพของ Messi ใช่หรือไม่ สำมำรถ
ทำำได้โดยใช้เมำส์คลิกที่จุดวงกลมสีฟ้ำ 
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• สุดท้ำยให้ดับเบิ้ลคลิกที่ไอคอน Data Table เพ่ือตรวจสอบข้อมูล 
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